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• This guide explains how to install the software programs and 
briefly introduces their functions and operating procedures. 

• Please read the software license agreement in this guide before 
using the software. By using the software, you agree to be 
bound by the terms of the agreement. 

Software Starter Guide
(For the Canon Digital Camera Solution Disk Version 16/17)
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You must install the software bundled on the Canon 
Digital Camera Solution Disk before connecting the 
camera to the computer.

Install the software. Connect the camera 
to the computer.



The precautions noted within this guide are intended to instruct you in the safe and correct use of 
the products and to prevent injuries or damage to yourself, other persons and property. Please 
read and ensure that you understand them before proceeding to other sections of the guide. 

Trademark Acknowledgments
• Canon and PowerShot are trademarks of Canon Inc.
• ArcSoft, the ArcSoft logo, ArcSoft PhotoImpression and ArcSoft VideoImpression are trademarks 

or registered trademarks of ArcSoft, Inc.
• Adobe is a trademark of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer 

Inc., registered in the United States and other countries.
• Microsoft, Windows and Windows logo are either registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.
• Netscape and Netscape Navigator are trademarks or registered trademarks of Netscape 

Communications Corporation in the United States and other countries. Netscape Communicator 
is a trademark of Netscape Communications Corporation.

• Other names and products not mentioned above may be registered trademarks or trademarks of 
their respective companies.

Copyright © 2004 Canon Inc. All rights reserved.

Canon Customer Support
For Canon Customer Support contacts, please see the Canon Limited Warranty supplied with 
your camera.

ArcSoft Customer Support
North America 
46601 Fremont Blvd., Fremont, CA 94538
Tel: (510) 440-9901 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions 
Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.

SAFETY PRECAUTIONS

Warnings This symbol indicates topics that could lead to death or serious injury if 
ignored or handled incorrectly.

Warnings
• Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-

ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the 
speakers. It is also possible to suffer from hearing loss from listening with headphones to 
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is 

accurate and complete, no liability can be accepted for any errors or omissions. Canon 
reserves the right to change the specifications of the hardware and software described 
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language in any form, by any means, without the prior 
written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a 
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards 
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.
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Canon Software License Agreement
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS 
BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.
This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE 
SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE DATA) AND THE 
USER MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND PROMPTLY RETURN THE 
SOFTWARE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and 
conditions of this Agreement.
1. LICENSE: Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another provided that the 
SOFTWARE is used on only one computer at a time. You shall not install or use the SOFTWARE on a 
network, multiple CPU, multiple site arrangement, or any other hardware configuration where the 
SOFTWARE is accessible to more than one CPU or to more than one user.
With respect to the sound and image data (“Data”) contained in the Software, which are to be 
downloaded to the applicable Canon digital camera product, Canon grants you a personal, non-
exclusive license to use the Data on a single Canon digital camera product only.
YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, 
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER, 
MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS 
EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or copy the 
SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the 
original for back-up purposes. Any other copying of the SOFTWARE is a violation of this Agreement. 
You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Neither Canon, nor its subsidiaries, dealers or distributors will be responsible 
for providing maintenance or support for use of the SOFTWARE. No updates, fixes or support will be 
made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, maintain 
and match the hardware and software components of your computer system. Thus Canon does not 
guarantee uninterrupted service or correction of errors or that the functions or performance of the 
SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND 
WITHOUT WARRANTY OR CONDITION OF ANY KIND. The CD-ROM storing the SOFTWARE is 
warranted only against defective material under normal use for a period of ninety (90) days after 
purchase from an authorized Canon dealer as evidenced by your sales receipt. Your sole remedy for a 
defective CD-ROM shall be replacement of the same without charge when returned by you at your 
expense to your point of purchase and proven to be defective upon inspection. The Replacement CD-
ROM will be warranted for the remainder of the original ninety (90) day warranty period of the 
defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM resulted from 
accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other than the 
original user of the SOFTWARE.
EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S SUBSIDIARIES, 
DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR CONDITIONS, EXPRESS OR 
IMPLIED, INCLUDING ANY WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR 
A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE 
FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT, 
CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE 
OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE 
THEREOF.

READ CAREFULLY BEFORE USING
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NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL 
HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A 
THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY 
INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE 
ON THE PART OF THE SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY 
TO YOU.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this 
Agreement by destroying the SOFTWARE. This Agreement will also terminate without notice to you if 
you fail to comply with any of the terms of this Agreement and you must then promptly return the 
SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995), 
consisting of “commercial computer software” and “commercial computer software documentation,” 
as such terms are used in 48 C.F.R. 12.212 (Sept 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 
227.7202-1 through 227.72024 (June 1995), all U.S. Government End Users shall acquire the 
SOFTWARE with only those rights set forth herein. Manufacturer is Canon Inc./30-2, Shimomaruko 3-
chome, Ohta-ku, Tokyo 146-8501, Japan.

7. EXPORT RESTRICTIONS: You agree to comply with all export laws and restrictions and regulations of 
the country involved, and not to export or re-export, directly or indirectly, the SOFTWARE in violation of 
any such laws and restrictions and regulations, or without all necessary approvals.

8. SEVERABILITY:
In the event that any provision of this Agreement is declared or found to be illegal by any court or 
tribunal of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction 
of that court or tribunal and all the remaining provisions of this Agreement shall remain in full force and 
effect.

9. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the 
United States of America shall be governed and construed in all respects in accordance with the laws 
and regulations of the State of New York, without reference to choice of law principles. The terms of 
this Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of 
the province of Ontario.

10.OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the 
SOFTWARE is subject to the laws of the United States, and Canada, and other applicable copyright and 
trademark laws, and nothing in this Agreement constitutes a waiver of the rights of Canon, its affiliated 
corporations and third party licensors under such laws. You only own the CD-ROM media in which the 
Software is stored. Except as expressly provided herein, no license or right, express or implied, is hereby 
conveyed or granted by Canon to you for any intellectual property of Canon. Nothing contained in 
Paragraph 1 shall be construed to give Canon any ownership rights in any images, graphics or textual 
material that you save in connection with the Software. 
You may not modify, remove or delete any or all copyright notices (i) which are contained in the 
Software, including any copy thereof, and (ii) which are on the original CD-ROM and on the medium of 
a back-up copy made pursuant to Section 2 above.

11.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE 
READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE 
STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER 
HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, 
AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT 
MATTER HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED 
BY A DULY AUTHORIZED OFFICER OF CANON.
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Using the PDF Manuals
The following PDF-format manuals (hereafter PDF manuals) are provided to 
explain the features and procedures for using ZoomBrowser EX and 
ImageBrowser.
•ZoomBrowser EX Software User Guide (Windows)
• ImageBrowser Software User Guide (Macintosh)

Adobe Reader or Adobe Acrobat Reader must be installed to read 
the aforementioned PDF manuals. If one of these applications is 
not already installed on your computer, download it from the 
following website. 
http://www.adobe.com/products/acrobat/readstep2.html

Viewing PDF Manuals
Viewing Manuals Downloaded from a Website
These PDF-format manuals are available on the Canon website. Use your 
browser program to download these manuals from the following URL:
http://web.canon.jp/Imaging/information-e.html



3

Read This First

This chapter explains what you can accomplish using the camera with the software contained 
on the Canon Digital Camera Solution Disk. 
It also lists the computer system configurations required to use the software.

About this Guide
•The explanations in this guide are based on Windows XP and Mac OS X v10.2. If you are 

using another version of these operating systems, the actual screen contents and 
procedures may vary slightly from those shown.

•This guide uses the following notations on the right to represent the items on the left. 
Mac OS X (v10.1/v10.2) -> Mac OS X 
Mac OS 9.0 - 9.2 -> Mac OS 9
CF Card, SD Card, PC Card -> Memory Card
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It’s so Simple! Make Prints Right at Home 
Like a Pro 

See your Camera User Guide for shooting instructions.

Just install the software once at the beginning.

Shoot the images

Install the software on the 
computer
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Download images to the computer

Print the images

Connect the camera to the computer
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Unbounded Possibilities with Entertaining 
Software
Print a Variety of Layouts
Print with the diverse layouts available in PhotoRecord (Windows) and ImageBrowser 
(Macintosh). The examples shown are from PhotoRecord (Windows).

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch. 

Confirm all your images in one glance with 
index (contact sheet) printing.

Make your own photo 
album of precious 
moments.
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Send an Image as an E-mail Attachment
Attach an image to an e-mail message by starting your mail software from within 
ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Operate the Camera Shutter from the Computer
Release the camera’s shutter from the computer with ZoomBrowser EX (Windows) or 
ImageBrowser (Macintosh). The recorded image is saved directly to your computer.

Edit a Movie
You can create and edit movies: link movies and stills that have been downloaded to your 
computer, add background music, superimpose titles and other text, and apply various effects 
to the movies. 

Convert a RAW Format Image
RAW images are extremely high-quality images that are free of the resolution loss associated 
with compression processing. However, since RAW images are created with a special image 
format, it is necessary to convert them to standard image file formats, such as TIFF or JPEG. You 
can make fine adjustments to the image quality and coloration when they are converted.

Release the shutter from the computer.
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System Requirements
Please install the software on a computer meeting the following minimum requirements.

Windows

•A CD-ROM drive is required to install the software.   
•All procedures performed with a connection to a USB 2.0 compliant board are 

not guaranteed.
•A sound card is required to play movie file audio tracks under Windows.
•Although the Macintosh version of the software is compatible with Mac OS X 

(v10.1/v10.2), it cannot be used with disks formatted with the Unix File System 
(UFS).

OS Windows 98 (First or Second Edition)
Windows Millennium Edition (Windows Me)
Windows 2000
Windows XP (Home Edition, Professional)

Computer Model The above OS should be pre-installed on computers with built-in USB 
ports.

CPU Windows 98/ Windows Me/ Windows 2000: Pentium 150 MHz or 
higher processor
Windows XP: Pentium 300 MHz or higher processor
For all of the above OSs: Pentium 500 MHz or higher processor is 
recommended (for editing movies)

RAM Windows 98/ Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more
For all of the above OSs: 128 MB or more is recommended (for 
editing movies)

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ZoomBrowser EX: 200 MB or more 

(Including the PhotoRecord printing program)
- PhotoStitch: 40 MB or more

•Canon Camera TWAIN Driver: 25 MB or more
•Canon Camera WIA Driver: 25 MB or more

Display 800 x 600 pixels/ High Color (16 bit) or better is required
1,024 x 768 pixels or better is recommended
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Macintosh

OS Mac OS 9.0 - 9.2, Mac OS X (v10.1/v10.2)

Computer Model The above OS should be pre-installed on computers with built-in USB 
ports.

CPU PowerPC

RAM Mac OS 9.0 - 9.2: 64 MB or more of application memory
Mac OS X (v10.1/v10.2): 128 MB or more

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ImageBrowser: 120 MB or more 
- PhotoStitch: 30 MB or more

Display 800 x 600 pixels/ 32,000 Colors or better is required
1,024 x 768 pixels or better is recommended
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Using the Software on the Windows 
Platform – Preparations

This chapter explains the basic procedures for installing the software and connecting the 
camera to a computer. Read this material before you connect the camera to the computer.

Installing the Software and USB Driver
Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare

•Your camera and computer
•Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT connected to 
the computer. 
If it is, disconnect the cable. The software cannot 
be properly installed if the camera is connected to 
the computer at the start.

2 Close any programs that are running. 

•You must install the software before you connect the camera to the 
computer. 

•Users of Windows XP and Windows 2000 must first log in as an Administrator 
(computer system administrator) to install programs. 
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3 Place the Canon Digital Camera Solution Disk in the 
computer’s CD-ROM drive.
If the installer panel does not appear automatically, use the 
following procedures. 

4 Click the Digital Camera Software 
[Install] button.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear 
automatically.

Windows XP
1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [Setup.exe]  icon.

Windows 2000, Windows Me, Windows 98
1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [Setup.exe]  icon. 
(Some computers may not display the [.exe] file name extension as shown above.) 

Follow any instructions to restart your computer, if they appear. If the 
following window appears, continue with the installation.

Installer Panel
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5 Click [Next].

6 Select [Easy Installation] as the setup 
type and click [Next].
Select [Custom Installation] to select 
programs individually for installation. 

7 Read the software license agreement and click [Yes] if you consent to all the 
conditions.

8 Review the installation settings and 
click [Next].
Follow the onscreen instructions to 
proceed.

The items displayed here differ according to 
the software installed.

When [Custom Installation] is Selected
The USB driver (the software for connecting) is required when the camera 
is connected to the computer with an interface cable. Ensure that you 
select a USB driver from below (the appropriate one for your operating 
system). 
•Windows 2000/Windows 98: Canon Camera TWAIN Driver 
•Windows Me: Canon Camera WIA Driver

With Windows XP, the USB driver supplied with the Windows operating 
system is used so there is no need to install a USB driver.



13

9 When the installation is over, select 
[Yes, I want to restart my computer 
now.] and click [Finish].

10 Remove the disk from the CD-ROM drive when your 
normal desktop screen appears after restarting.
This concludes the software installation. 
Continue by connecting the camera to the computer so 
that the USB driver can be utilized. 

Users of Windows XP and Windows 2000 must log in as an Administrator 
(computer system administrator) after restarting to carry out the 
subsequent procedures. 

If you installed a USB driver, so far the required files have only been 
copied to your computer. You must now connect the camera to the 
computer with the interface cable to complete the installation and 
prepare the driver for use. 

See Uninstalling the Software (p. 79) to delete the installed programs.
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11 Attach the camera to the computer with the 
interface cable and set it to the correct mode 
for connecting.

The USB driver will automatically finish installing onto the computer when you attach the 
camera and open a connection. Dialogs similar to the following ones will appear during 
this process (first connection only).

Windows XP 
The dialog on the right will appear after a 
few moments and the USB driver supplied 
with the Windows operating system will 
automatically install.

Windows 2000/Windows Me/Windows 98 
A window such as the Add New Hardware Wizard will appear after a moment.

Restart the computer according to the instructions if you are prompted to do so by a 
message.

A dialog allowing you to set the default settings will display after installation. See Using 
the Software on the Windows Platform – The Basics (p. 15) for the subsequent 
procedures.

This concludes the software and USB driver installation and the procedures for connecting the 
camera to the computer.
You may now download camera images to the computer (p. 15). 

Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See 
Information about Your Camera (p. 92). 

•See USB driver installation not proceeding well in the Troubleshooting
section (p. 83) if you are having problems installing the USB driver.

•See Uninstalling the USB Driver (p. 79) to delete the USB driver installed 
with these procedures.

•See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 91) if you 
were previously using either version. 
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Using the Software on the Windows 
Platform – The Basics

This chapter explains the procedures for using ZoomBrowser EX to download the camera's 
images to the computer and print them.
Read this chapter after completing the preparations in the Using the Software on the Windows 
Platform – Preparations section. 

Downloading Images to the Computer
Begin by starting up ZoomBrowser EX and downloading images to your computer. The startup 
procedures vary slightly according to whether you are connecting the camera to the computer 
or using a memory card reader. 

Camera to Computer Connection

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
Digital Terminal. Prepare the camera for communication with the computer.

•See Information about Your Camera (p. 92) to confirm whether your camera 
model supports the Direct Transfer function.

•You can change the settings for the images to be downloaded and the 
downloading destination by clicking the [Camera] menu in ZoomBrowser 
EX’s main window and selecting [Auto-download setting].

•You can also display an index of the camera or memory card images to check 
them before downloading or download them selectively. For instructions, 
see Checking Images before Downloading (p. 26). 

A window stating that the server is busy may display while images are 
downloading. If this happens, wait a moment and click the [Retry] button 
(p. 90).

Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See 
Information about Your Camera (p. 92). 
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2 Download the images.
Use the computer or camera to download 
images described as follows.

The window may appear slightly different 
with some camera models.

You can confirm information such as the 
destination folder for images.

Perform the following settings the first time you connect the camera to the 
computer. 
These procedures are not required from the second time onward.

1. Select [Canon CameraWindow] when 
a dialog (Events dialog) similar to that 
on the right displays and click [OK].

Your camera model name or "Canon 
Camera" will appear here.

If the Events dialog fails to display, click the [Start] menu and select 
[Programs] or [All Programs], followed by [Canon Utilities], 
[CameraWindow], and [CameraWindow Set Auto-Launch]. Proceed to 
Step 2.

A dialog allowing you to select the camera model will display if a 
camera and a memory card reader are connected at the same time. 
Confirm that your model name or “Canon Camera” is displayed and 
click [OK].

2. Click [Set].
You must repeat Steps 1 and 2 above 
the next time you connect when you 
select the Don’t Set option.
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Using the Computer to Download Images
Click [Start Image Download].

Using the Camera to Download Images (Direct Transfer Function)

Set the Direct Transfer settings with the 
camera.

The camera images download to the computer. The downloaded images are saved into 
folders according to the shooting date.

When downloading is complete, the 
thumbnails (tiny versions) of the 
downloaded images display in 
ZoomBrowser EX’s main window. 

Next, print out the images (p. 19). 

All the images that have not yet been downloaded will download 
according to the default setting.

If your camera supports the Direct Transfer function, the Print/Share 
button ( ) will light up, and a Direct Transfer menu like that shown 
below will appear on the LCD monitor. See Information about Your 
Camera (p. 92) to confirm whether your camera model supports the 
Direct Transfer function.

Since sound memos cannot be downloaded using a camera operation, 
click [Download images to computer] to download sound memos.

•See the Camera User Guide for instructions regarding Direct Transfer 
settings and procedures. 

•You cannot use the camera’s Print/Share button to download when it is 
not lighted.

Thumbnail
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Memory Card Connection

1 Insert the memory card into the reader.
Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card for its connection and handling instructions.

2 Double-click the [ZoomBrowser EX] icon 
on the desktop.

3 Click [Camera & Memory Card], followed by [Browse & Download Images].

4 Click [Start Image Download] when the 
Download image window opens.

You can confirm information such as the 
destination folder for images.

A selection dialog will appear if multiple memory card readers loaded 
with memory cards are connected or if a camera and memory card reader 
are connected. Select one device and click [OK].

(1) Place the memory card in 
an adapter if required.

(2) Insert the loaded adapter 
into the slot.
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The memory card images download to the computer. The downloaded images are saved 
into folders according to the shooting date.

When the download is complete, the thumbnails (tiny versions) of the downloaded 
images display in ZoomBrowser EX’s main window. 

Next, print out the images. 

Printing Images
This section explains the basic procedures for using PhotoRecord, a printing utility program. See 
the program’s [Help] menu for more details.

1 Click [Print] in the main window, followed by [Layout Print].

2 Select an image to print and click the 
[Next] button at the window’s bottom 
right.

•See Memory Card Folder Structure (p. 82) for information about 
memory card folder structures and file names.

•Movies cannot be printed.
•With images shot by Exif 2.2 (called Exif Print) compatible cameras, shooting 

information such as the shooting settings and mode can be included with 
the images. This data is then used to correct the images to obtain better 
prints.

•PhotoRecord automatically carries out image correction (as a default setting) 
with both images shot with Exif 2.2 compatible cameras and other images, 
yielding high-quality prints.

The background color of the selected images 
will change to orange.
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3 Place a check mark beside the data you 
wish to include with the print (multiple 
selections are possible) and click 
[Finish].

For example, you can print the shooting date 
and time with the image if you select [Date 
and Time] here.

PhotoRecord will start, displaying the 
selected image and the information 
selected in Step 3 in the Album window.
In addition, the steps that will take you 
through the printing process will display on 
the left side. Follow the steps in order to 
proceed. 

The next steps differ according to whether you select Full Page Print (one image per page) 
or Layout and Print (multiple images arranged on one page).

To add a comment to an image, select it in ZoomBrowser EX and click 
[Properties].

Album Window
The selected images display 
here.

The printing procedures display here.
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Full Page Print

This option prints one image per page. 

1 Click [2 Select Printer & Album Type]. 
Once you have chosen a printer, select 
[Others] in the Album Type category, 
followed by [One Photo Per Page].

2 Click [3 Select paper] and select the 
paper size and orientation.

3 Click [4 Print], confirm the number of 
copies and other printing settings, and 
click [Print]. 

This will initiate printing. 
To close PhotoRecord after printing is complete, click . Click [Yes] to save the album or [No] 
to close it without saving. The ZoomBrowser EX window will reappear when the save 
procedure is complete.



Printing Images22

Layout and Print

This option prints multiple images on a single page as in a photo album. 

1 Click [2 Select Printer & Album Type]. 
Once you have chosen a printer, select 
an album type. 

2 Click [3 Select paper] and select the 
paper size and orientation.

3 Click [Decorate Album] and change the 
design of the image background and 
border as required. 

Click the [Themes], [Backgrounds], [Photo 
Frames], [Text Frames] or [Clipart] button to 
switch between selections.

Perform the procedures according to the 
instructions beside the  symbol. 

Booklet: creates a margin at the left side so the album can be bound 
Simple Album: creates equal margins on both sides
You can also change the margins by clicking [Margins].
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4 Click [4 Print], confirm the number of 
copies and other printing settings, and 
click [Print]. 

This will initiate printing. 
To close PhotoRecord after printing is complete, click . Click [Yes] to save the album or [No] 
to close it without saving. The ZoomBrowser EX window will reappear when the save 
procedure is complete.

This chapter explained the ZoomBrowser EX basics. Once you have mastered them, read 
the following chapter to try the advanced techniques.
Using the Software on the Windows Platform – Advanced Techniques (p. 24). 

•The [Themes] category provides consistent designs for use throughout 
an entire album.

•You can also click [Add Titles & Captions] to add text as a title or caption. 

Printing a Contact Sheet
If you click [Print] in the main window (p. 19) and select [Contact Sheet Print] instead 
of [Layout Print], you can print image thumbnails along with the Exif data* (shooting 
information).
* There is a difference between the shooting information shown in ZoomBrowser EX 

and the Exif information that can be printed with PhotoRecord.

•A PDF-format manual for ZoomBrowser EX is also available. It provides 
further information about the program's features and procedures. See 
Using the PDF Manuals (p. 2).
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Using the Software on the Windows 
Platform – Advanced Techniques

This chapter explains various ZoomBrowser EX features, such as how to play movies and create 
panoramic images.
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the 
Using the Software on the Windows Platform – The Basics chapter.

The ZoomBrowser EX Windows
ZoomBrowser EX has two windows: the Main Window and the Camera Window.

Main Window

This window can be used for more than just organizing downloaded images. For example, you 
can use it to print images or attach them to e-mail messages.

Folders Area
You can view folder contents here just like in 
Windows Explorer.

Task Buttons
These buttons select 
the task to carry out.

Browser Area 
Displays the images contained in the folder 
selected in the Folders Area. Double-clicking an 
image shows it at a larger size.

Function Buttons
These buttons apply functions to images 
selected in the Browser Area.
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Camera Window

This window can be used to view images in the camera (or memory card) and download the 
images to the computer as you confirm them. 

You can change the zoom speed for images displayed in the Browser Area. 
Click the [Tools] menu, select [Preferences] and slide the [Zooming] lever.

ZoomBrowser EX comes with a function that rotates, downloads and displays 
images, shot vertically or horizontally, in their correct viewing orientation. 
(Rotating images does not affect image quality)

Only the rotated image is saved to the computer with the following camera 
and image settings.
•When JPEG images are shot with the camera's [Auto Rotate] function set 

to [On].
•When JPEG images are rotated with the camera’s manual rotation settings.
•When JPEG images are rotated in the Camera Window
To download both the pre-rotation and post-rotation images, click the 
[Tools] menu in ZoomBrowser EX's main window and select [Preferences], 
followed by the [Rotation] tab. Place a check mark beside [Rotate a copy of 
the JPEG image].

The images from the camera (or 
memory card) display here.

Function Buttons
These buttons apply functions to images 
selected in the Camera Window.

Task Buttons
These buttons 
select the task 
to carry out.

A window allowing you to specify the download 
destination opens when you select images and 
click the [Download image] button.
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Checking Images before Downloading
You can check camera or memory card images in the Camera Window before processing 
them. You can also choose to download only the images you select in the Camera Window. 

1 Display the Download Image window. 
To download images from a camera, follow Steps 1-2 in the Camera to Computer 
Connection section (p. 15). 
To download images from a memory card, follow Steps 1-3 in the Memory Card 
Connection section (p. 18). 

2 Click [List Images].
The window may appear slightly different 
with some camera models.

The Camera Window shows thumbnails (tiny versions) of the camera or memory card 
images.

3 Click on images in the Camera Window that you wish to download. 
The background color of the selected images will change to orange.

If you are downloading images previously selected with the camera’s 
[Transfer Order] setting, click [Select] and select [Select Send mark].

ThumbnailThe movie icon displays on movie thumbnails.

RAW will appear beneath the thumbnails of RAW 
format images.
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4 Click [Download image].

5 Confirm the destination folder and click 
[OK].

Specify the destination folder for the 
image(s).
(You can change the destination folder by 
clicking [Browse] and selecting a new 
destination.)

Select [Create new folder] to create a new 
folder within the one specified above, and 
select a naming option.

The downloaded images will appear in the 
main window.
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Replaying Movies

1 Double-click an image with a movie 
icon in ZoomBrowser EX’s Browser 
Area. 
QuickTime Player will start. 

2 Click the play button  in QuickTime 
Player.
The movie will replay.

Other Methods of Downloading Images to the Computer
There is no need to install ZoomBrowser EX with either method.

* Windows XP (Installation of USB Driver Not Required)
Your camera uses a standard image transfer protocol called the Picture Transfer Protocol 
(PTP). With the PTP and Windows XP, all you need do is connect the camera to the 
computer with an interface cable to download images. It is easy using the Scanners and 
Cameras Wizard and other procedures. However, there are some inconveniences and 
limitations to this downloading method. See the For Windows® XP and Mac OS X Users
leaflet for details. 

* Windows Me (with the USB driver installed)
It is easy to download images using the Scanners and Cameras Wizard or Windows Explorer. 
All you need do is connect the camera to the computer with an interface cable.

See the Windows Help system for information about the Scanners and Cameras Wizard and 
Windows Explorer. 

Do not double-click a movie file (.AVI extension) in the Windows Explorer to 
play it. That will start Windows Media Player, which may not support this file 
type. To replay movies, start QuickTime Player through the [Start] menu and 
open the file using the QuickTime Player [File] menu.
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Editing Movies
You can create and edit movies: link movies and stills that have been downloaded to your 
computer, add background music, superimpose titles and other text, and apply various effects 
to the movies. 

1 Click [View & Modify] in ZoomBrowser EX’s main window, followed by [Edit 
Movie].

2 Select the image(s) to edit in the Browser Area (movies or stills) and click [Next].
You can select multiple movies or stills.

Installation Procedures for QuickTime
1. Set the Canon Digital Camera Solution Disk in the CD-ROM drive.

The installer panel will automatically appear. (Display it with the procedures in How to 
Display the Installer Panel (p. 11) if it does not appear.)

2 Click the QuickTime 6.3 [Install] button.

Follow the onscreen instructions to proceed with the installation.

Movies are saved as AVI files in the Motion JPEG (MPEG) format.
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3 Follow the steps at the left of the window to edit the movie and save it. 

Searching Images
You can search for images marked as your Favorites or by such parameters as the modification 
date, shooting date or keywords. The procedures for marking images as Favorites and adding 
keywords to them are explained in the following pages. 

1 Select a folder to search in the Browser Area. 

2 Click [View & Modify], followed by [Search] in the next menu. 

3 Set the search parameters.
Place a check mark in the parameter you wish to use. 

Click this button to 
play the movie 
being edited.

Follow these steps 
to proceed.

Storyboard Area
Displays thumbnails of the selected 
images.
Links images in order from left to right.

Click this button for detailed 
operational instructions.

Transition Effects Box
Appears between adjacent images 
and displays the symbols of the 
transition effects linking images.

Guidance
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If you selected the modification or shooting date, set the date range. If you selected the 
keyword option, select the keywords.

4 Click [Next] after setting the search 
parameters. 

5 If the search results are satisfactory, 
click the [Finish] button. 
To change the parameters and execute 
another search, click [Back] and repeat 
steps 3-4. 

This concludes the search process. 
The images that met the search criteria will 
be contained in the Search Results folder in 
the main window. You can select, print or 
copy these images to another folder. The 
images will display in this folder until 
ZoomBrowser EX is closed or another 
search is performed.

Folder containing the images satisfying the 
search parameters

Set the parameters 
here. 

Sets whether 
images are 
searched 
according to all the 
parameters or just 
one.

Clicking here allows 
you to hide the search 
parameter details.

Images satisfying the 
search parameters
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Setting Image Parameters for Future Searches

Placing a Check Mark in the Favorites Box
Adding a check mark to the Favorites box makes it easy to perform searches on images later.

1 Select the image in the Browser Area and click  (Properties).
The Properties window will display. 

2 Click the [Favorite Photo] box to add a 
check mark and close the Properties 
window. 
This concludes the process for marking an 
image as one of your favorites. 

The symbol shown on the right is displayed 
on images marked as your favorites. 

Adding Keywords to Images
Add searchable keywords to images. 

1 Select the image in the Browser Area and click  (Properties).
2 Click [View/Modify Keywords].

Favorites Symbol
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3 To add an existing keyword to an 
image, click the keyword to add a check 
mark beside it.

Select an existing keyword to add to an 
image.

4 Click [OK].
This completes the procedures for adding keywords to images.

Converting RAW Images
RAW images are extremely high-quality images that are not subject to any deterioration due to 
compression processing. Since they are recorded with a special file format, they cannot be 
opened by many image editing programs. It is necessary to convert them to standard image file 
formats, such as TIFF or JPEG.

Procedures for Converting RAW Images

1 Select a RAW image in ZoomBrowser EX’s Browser Area. 
2 Click [View & Modify], followed by [Process RAW Images].

•See Information about Your Camera (p. 92) to determine whether your 
camera model supports this function.

•See the Camera User Guide for information about the camera settings for 
shooting RAW images.

To add a new keyword, type the new word 
in the box to the left and click the [+] 
button.
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The main window, the Navigator window 
and the Image Quality Adjustment Window 
will display.

Use the buttons here to switch between 
images and display modes, rotate images, 
and set the conversion parameters.

Thumbnail
Check Mark

3 Adjust the image quality as required in the Image Quality Adjustment Window.
This window is explained in the Functions of the Image Quality Adjustment Window
section.

4 Click the [2. Save] tab, set the file 
format and destination, and then click 
[Save].

Select [All Images] or [Checked Images] 
(images checked in the main window) to 
apply the common conversion settings.

Select a file format

Set the file destination

You can also change the image file name

This will convert the image.

5 Click the [3. Exit] tab and click [OK].

If the navigator window or the Image Quality Adjustment Window do 
not display, click the [View] menu and select [Show Navigator] or [Show 
Image Quality Adjustment Window].

Main Window
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Functions of the Image Quality Adjustment Window

The following adjustments can be made in the Image Quality Adjustment Window.

You can change the coloration of the image to your preferred settings when 
you convert a RAW image. You can also select preset color schemes, such as 
Positive Film. Furthermore, you can add your own color schemes (My Color) to 
apply to other RAW images when they are being converted. See the PDF 
manual for ZoomBrowser EX for more information (p. 2).

This section adjusts the 
white balance according 
to the light source and 
color temperature.

This section adjusts the 
digital exposure, photo 
effect, contrast, 
sharpness, and saturation.

The effect of the settings 
above can be viewed 
immediately if you place a 
check mark here.

Tone Curve Tab
You can set the levels for 
the RGB channels 
separately or together.

Advanced Adjustments 
Tab
You can set the settings 
for adaptive noise 
control, false color filter 
and the color space for 
the output.

If you cannot set the 
desired setting with the 
slider on the left, directly 
enter the setting here.

Restores all settings to the 
settings stored in the camera at 
the time of shooting.

Applies the settings to 
the displayed image
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Operating the Shutter Remotely
You can record still images by using a computer to control the shutter of a connected camera. 
This is particularly useful for checking images on the larger display of the computer as you 
record them and for high volume photography without worrying about filling the camera’s 
memory card.

Preparing for Remote Shooting

1 Ensure that the camera is connected to the computer and that ZoomBrowser EX is 
displaying its main window.

2 Open the lens cover or remove the lens cap on models equipped with them.
 Proceed to the next step if your model does not have one. 

3 Click [Cancel] if the Events dialog appears.
4 In the Browser Area, select the folder in which images will be saved.

The folder selected here will be the folder into which the remote shooting images are 
saved.

5 Click [Camera & Memory Card], followed by [Remote Shooting] 

Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See 
Information about Your Camera (p. 92).
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RemoteCapture Task Window 

The RemoteCapture Task window has the following features.

•The settings available in the RemoteCapture Task window vary between 
camera models. 

•RemoteCapture Task locks the exposure and focus settings for the subject 
matter in the Viewfinder section. If the lighting or distance to the subject 
changes, click  to reset these settings.

Size and Resolution Selector
Selects the size and resolution at which images are captured.

You can add 
comments to images 
by placing a check 
mark here and 
typing text in the 
boxes below. 

Viewfinder Display
Click the [Start/Stop 
Viewfinder] button 
while a connection to 
the camera is open to 
display the image 
appearing in the 
camera’s viewfinder.

Slide this to zoom 
the camera in or out.

Set the basic camera settings here.

Rotation Settings
Sets the rotation 
parameters for 
images after they are 
captured.

Shows/Hides the 
viewfinder or detailed 
settings area.

Release Button
Releases the 
shutter.

Start/Stop Viewfinder 
Button
Starts or stops the 
viewfinder display.

Refresh Button
Resets the exposure, 
focus and white 
balance.
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Remote Shooting

1 Click  and check the subject in the viewfinder.
2 Change the image size or resolution, the rotation settings and the settings at the 

bottom of the window as required. 
If you intend to tilt the camera 90 degrees on end to photograph a person, you can save 
the image to the computer with the correct orientation if you set the rotation settings in 
advance.

3 Click the [Release] button.
The recorded image is saved to the folder that was displayed in the window when the 
remote shooting procedures were initiated.

Ensure that you turn off your computer’s standby mode before you begin 
remote shooting. The device performance cannot be guaranteed if the 
computer enters the standby mode.

If your camera is equipped with the Auto Rotate function and you set it 
to On, the image will automatically be rotated and appear in the correct 
viewing orientation in the RemoteCapture Task window.

•You can release the shutter by pressing the camera’s shutter button or 
the keyboard’s space key.

•The zoom controls and other camera buttons and switches, except for 
the shutter button, cannot be operated while the camera is being used 
for remote shooting.

•You may notice that the interval between the shutter release and 
activation is slightly longer for remote shooting than when the camera 
is used independently. 
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Other Features 

Changing the File Saving Method
1 Click the [File] menu in the RemoteCapture Task window and select [Preferences].

2 Select a file settings option and click 
[OK].

Sets whether images are saved only to the 
computer or to both the computer and the 
memory card in the camera.

Input a root name for the image files here. If 
you input “Capture”, for example, the first 
image will be named [Capture_00001.JPG] 
and successive images will automatically be 
assigned a name that is one number higher 
than the last. You can also change the 
number of digits and the starting number.

The recorded images are saved to this folder. 

Displaying the Subject in the Camera's LCD Monitor
You can view the subject you are shooting in the camera’s LCD monitor. 

1 Click the [Camera] menu in the RemoteCapture Task window and select [Camera 
Display Settings].

2 Select [Camera LCD monitor] and click [OK]. 
3 Click the  icon in the RemoteCapture Task window. 

Selecting [Computer only] in the "Save Images On" category allows you 
to shoot when there is no memory card in the camera or when the 
camera's memory card is full.

You can display the subject on a TV connected to the camera by selecting 
[Video Out terminal] in Step 2. See the Camera User Guide for 
instructions to connect the camera to a TV.
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Merging Panoramic Images - PhotoStitch 
You can create a wide panoramic image by merging several images, such as those shot in the 
camera's Stitch Assist mode.

Starting PhotoStitch 

1 Click [View & Modify] in the ZoomBrowser EX’s main window and click [Stitch 
Photos].

2 Select a series of images in the Browser 
Area and click [Finish].

Follow the instructions to merge the images.

3 Merge the images following the instructions in the guidance panel at the top of 
the PhotoStitch window.

Images Shot in Stitch Assist Mode 

It is easy to merge images shot with the camera's Stitch Assist mode since PhotoStitch 
automatically arranges them in the correct order and orientation. 

•QuickTime 3.0 or a later version is required to save the merged image in 
the QuickTime VR format. (QuickTime is supplied on the Canon Digital 
Camera Solution Disk.)

• Images shot in Stitch Assist mode with a wide converter, teleconverter 
or close-up lens cannot be merged accurately. 

Images shot in Stitch Assist mode display a mark like this. 
Camera Window
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Saving Images on CD-R/RW Disks (Windows 
XP Only)
You can copy and save ZoomBrowser EX images to CD-R/RW disks. The shooting information is 
copied along with the images. 

1 Place a CD-R/RW disk in the drive.
2 Click [Cancel] to close it if a dialog like 

that on the right appears. 

3 Click [View & Modify] in the ZoomBrowser EX main window and click [Backup to 
CD].

4 Follow the instructions at the left of the display to proceed. 
The disk will automatically eject from the drive once the files have been copied to it. 

•You can start PhotoStitch by clicking the mark shown on images shot in 
Stitch Assist mode.

•See the Camera User Guide for information about shooting in Stitch Assist 
mode.

This feature is only possible on computers that satisfy the following 
requirements. 

•Windows XP was pre-installed on the computer
•The CD-R/RW drive came as standard equipment with the computer

Additional images can be copied onto a CD-R/RW disk with sufficient 
space that has already been written to once. 
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Enjoy Customizing Your Camera with the My 
Camera Settings
The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are 
called the My Camera Settings. You can add your favorite images and sounds from your 
computer to the My Camera Settings. This topic explains how to upload the My Camera 
Settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window

1 Connect the camera to the computer and start ZoomBrowser EX.
2 Click the [Camera] menu in the main 

window and select [My Camera 
Settings].

The My Camera Window Features

ZoomBrowser EX already contains several pre-recorded My Camera Settings items. You can 
check these items with the My Camera window.

Tabs 
Click here to switch between adjusting the settings individually or in themed sets.

Displays the list of 
settings files saved 
onto the computer.

Add File Button
Adds the settings file 
to the list.

Play Button
Plays the audio from 
the selected settings 
file.

Delete Button
Deletes a settings file from 
the computer. 

Delete Button
Deletes a settings file 
from the camera.

Displays the settings in 
the camera.

Play Button 
Plays the audio from the 
settings file in the 
camera.

Save to Camera Button
Saves a computer 
settings file onto the 
camera.

Save to PC Button
Saves a camera settings 
file onto the computer.
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Saving the My Camera Settings to the Camera

1 Select the [Setup as a theme] tab in the My Camera window. 
To set the start-up image or sound individually, click the [Set individually] tab and select it.

2 Select the settings file you wish to save to the camera from the My Computer list. 
3 Select the setting from the Camera list that you would like to change and click 

[Save to Camera].
This concludes the process of saving the My Camera settings to the camera.
The Camera list setting will change to the selected file. If a setting for this category has 
previously been saved to the camera, it will be overwritten. 

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound settings on the 
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer

1 Select the [Setup as a theme] tab in the My Camera window. 
To set the start-up image or sound individually, click the [Set individually] tab and select it.

2 Select the settings file(s) from the Camera list that you wish to save to the 
computer.

3 Click [Save to PC].
4 Add a name to the settings file you are saving and click [OK].

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

You can add new data to the My Camera window. See Adding New Data to 
the My Camera Window (p. 44). 

•My Camera Settings can be selected and saved in either of two ways to the 
camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the start-up image 
and animal calls in each of the sound files. The names of the prepared files 
for the various My Camera Settings themes all begin with the same root 
name, such as “Animal~”. For example, the start-up image that starts with 
“Animal~” shows an animal picture while the similarly named sound files 
feature animal sounds.

Do not detach the interface cable, turn the camera power off or disconnect 
the camera from the computer while the My Camera Settings are being saved 
to the camera or the settings from the camera are being saved to the 
computer. 
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Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.

Create an Original Start-up Image File and then Add It
Start by using an image editing program to create the image file that will become the start-up 
image and save it to the computer. Create the file in the JPEG format at a size of (w) 320 x (h) 
240 pixels.

1 Open the My Camera window, click the 
[Set individually] tab, select [Startup 
Image] from [Data Type] and click the 
[Add File] button.

2 Select the file you created and click [Open].
This concludes the process for adding new data.
You can save the newly created data to the camera using the procedures described in the 
Saving the My Camera Settings to the Camera section (p. 43).

Create an Original Sound File and then Add It (Example: Start-up Sound)
It is easy to create a sound file using the My Camera Sound Maker window.
QuickTime is required to play the recorded sound.

1 Click the [Camera] menu in the ZoomBrowser EX main window and select [Create 
a My Camera Sound]. 

2 Click the [1. Start-up Sound] tab, 
followed by the [Record] button.

To open a sound file already saved to the computer, click the [Open] 
button in place of the [Record] button. Then skip to Step 6.
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3 Click the [Start] button.

4 When the recording is complete, click the [Stop] button, followed by the [Close] 
button.
Recording will stop after 30 seconds elapses even if the Stop button is not clicked. In that 
case, just click the [Close] button.

5 Click the [Sound Format] button as required and select a sound format.
6 Edit the sound data so that it conforms to the time limits. 

Adjust the time of the recording with the blue or red switch. 
The extra data outside the starting and finishing switches can be erased by clicking the 
[Cut] button.

7 Click the [Save] tab, confirm that the sound file was created, input a file name and 
then save it. 

8 Click the [Save] button, add a file name and save it.

9 Click  to close the My Camera Sound Maker window. 
This concludes the process of adding a sound file as a My Camera settings file to the 
computer.
You can add the file to the camera with the procedures described in the Saving the My 
Camera Settings to the Camera section (p. 43).

Repeats steps 2-8 as required to create sound files for the shutter sound, 
operation sound and self-timer sound. 

Volume Control

Starting position of 
sound (blue switch).

Play Stop Rewind

Finishing 
position of 
sound (red 
switch)
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•Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono sound in 
the WAV format. The following chart shows standard time lengths for 
My Camera Sounds.

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Using the Software on the Macintosh 
Platform – Preparations

This chapter explains the basic procedures for installing the software. Read this material before 
you connect the camera to the computer for the first time.

Installing the Software
Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare

•Your camera and computer
•Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

Installation Procedures

1 Close any programs that are running. 
2 Place the Canon Digital Camera Solution Disk in the 

computer’s CD-ROM drive.

3 Double-click the CD-ROM icon, followed by the [Mac 

OS X] and [Canon Digital Camera Installer]  icons.
With Mac OS 9, double-click the CD-ROM icon, followed 
by the [Mac OS 9] and [Canon Digital Camera Installer] 

 icons.

4 Click the Digital Camera Software 
[Install] button. 

Installer Panel
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5 Select [Easy Installation] and click 
[Next].
Select [Custom Installation] to select 
programs individually for installation. 

6 Read the software license agreement and click [Agree] if you consent to all the 
conditions.

7 Review the installation settings and 
click [Next].
Follow the onscreen instructions to 
proceed.

8 When the installation is over, click [OK].

9 Remove the disk from the CD-ROM drive.
This concludes the software installation. 
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Continue by downloading images to the computer (p. 50). 

See Uninstalling the Software (p. 81) to delete the software installed 
with these procedures.
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Using the Software on the Macintosh 
Platform – The Basics

This chapter explains the procedures for using ImageBrowser to download the camera's images 
to the computer and print them.
Read this chapter after completing the preparations in the Using the Software on the 
Macintosh Platform – Preparations section. 

Starting ImageBrowser
Begin by starting up ImageBrowser. The startup procedures vary according to whether you are 
connecting the camera to the computer or using a memory card reader. 

Camera to Computer Connection

Mac OS X
1 Attach the supplied interface cable to the computer’s USB port and the camera’s 

Digital Terminal. Prepare the camera for communication with the computer. 

iPhoto or Image Capture will automatically start when the camera and computer are 
ready to connect. If either of these programs does not start, proceed to Step 3.

2 Click  at the upper left of the iPhoto or Image Capture window to close it.
3 Double-click the [Canon ImageBrowser] icon on the desktop. 

If the Canon ImageBrowser icon does not appear on the desktop, 
double-click the [Canon Utilities] folder on the drive on which the 
program was installed, followed by the [ImageBrowser] folder and 
[ImageBrowser] icon.

4 Click [Canon Camera] in the Explorer 
View section.
The Communication Settings dialog will 
display. This dialog will only appear the first 
time the camera is connected. 

Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See 
Information about Your Camera (p. 92). 

Explorer View Section
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5 Confirm that [USB port] is selected as 
the port option and that your camera 
model name or [Canon Camera] are 
selected as the detected camera. Click 
[Set].
iPhoto or Image Capture may automatically 
start up at the same time as the Camera 
Window. Step 6 is not required when 
neither program starts up automatically. 

6 Click the  icon at the top left of the iPhoto or Image Capture window to close 
the program. 

7 Confirm that the images from the 
camera are displayed as thumbnails 
(tiny versions) in the Camera Window.

Thumbnail

Camera Window
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Mac OS 9
1 Attach the supplied interface cable to the computer’s USB port and the camera’s 

Digital Terminal. Prepare the camera for communication with the computer.

How to Set ImageBrowser to Start Automatically with Mac OS X 
You can have ImageBrowser start automatically when you connect the camera to the 
computer by adjusting the following settings.
Mac OS X v10.2
1. Start Image Capture, click the [Image Capture] menu and select [Preferences].
2. In the next menu, click the [Camera Preferences] list box and select [Other]. 

3. Select [ImageBrowser] in the program selection window.
4. Close Image Capture.
ImageBrowser will start automatically from the next connection onward.

Mac OS X v10.1
1. Start Image Capture and select [Other] from the Hot Plug Action list box.

2. Select [ImageBrowser] in the program selection window.
3. Close Image Capture.
ImageBrowser will start automatically from the next connection onward.

Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See 
Information about Your Camera (p. 92) for details. 



53

2 Once the ImageBrowser Automation 
Wizard appears, confirm that [Display 
Images] is selected and click [OK].

The Communication Settings dialog will display.
This dialog only appears the first time the camera is connected.

3 Confirm that [USB port] is selected as 
the port option and that your camera 
model name or [Canon Camera] are 
selected as the detected camera. Click 
[Set].

The Camera Window will open and display 
the camera’s images as thumbnails (tiny 
versions). 

To download images with transfer order settings, select [Download 
images] and click [Next]. Select [Download images marked for 
transferring] and click [OK].

In the ImageBrowser Automation Wizard dialog, you can select the 
action that is carried out after ImageBrowser starts.

Confirm that this option is selected.

Camera Window

Thumbnail
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Next, download images to the computer (p. 56).

What to Do the Next Time ImageBrowser is Started 
A dialog with the previously selected automated settings will display the next time you 
start ImageBrowser. To use these settings unchanged, click the [Start] button. To do 
nothing, click [Cancel]. To change the settings, click [Settings change].

How to Set ImageBrowser to Not Start Automatically
1. Click the Apple menu  and select [Control Panels] and [Canon ImageBrowser 

Auto Launch].
The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to clear the check mark.
3. Click the close box  at the upper left to close the window.

To change the settings, click [Settings Change] and select the desired action in 
the ImageBrowser Automation Wizard dialog and click [OK].

Click here to close the window.

Clear the check mark here to 
stop ImageBrowser from 
starting automatically.
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Memory Card Connection

1 Insert the memory card into the reader.
Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card for its connection and handling instructions.

2 Double-click the [Canon ImageBrowser] icon on the desktop.

If the icon does not appear on the desktop, double-click the folder in which you installed 
the program, followed by the [Canon Utilities] and [ImageBrowser] folders and the 
[ImageBrowser] file.

3 Double-click the [DCIM] folder in the 
Explorer View Section.

The images from the memory card will 
display as thumbnails (tiny versions) in the 
Camera Window. 

(1) Place the memory card in 
an adapter if required.

(2) Insert the loaded 
adapter into the slot.

Mac OS X Mac OS 9

Explorer View 
Section

Camera Window

Thumbnail
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Next, download images to the computer (p. 56).

Downloading Images to the Computer

Creating a Folder to Receive Downloaded Images 

Create a new folder for downloaded images with the following procedures.

1 Click the window labeled [Browser Window] and bring it to the foreground.
2 Select the [Users] folder and the subfolder labeled with the user name under 

which you are logged in on the startup disk.
Mac OS 9 users should select [Macintosh 
HD] in the Explorer View section. 

Explorer View Section

3 Click the [File] menu and select [New 
Folder].
This will create a folder labeled “Untitled.”

4 Input a new name and press the [return] key.
This will replace the name with the one you 
type.

See Memory Card Folder Structure (p. 82) for information about memory 
card folder structures and file names.
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5 Select the newly created folder.

Downloading Images

Download images to the new folder created in Creating a Folder to Receive Downloaded 
Images.

1 Click the Camera Window to bring it to the forefront.
2 Click the images to download.

A blue frame appears around selected 
images.

You can select multiple images by holding the [shift] key while clicking 
images.

Thumbnail The movie icon 
displays on movie 
thumbnails.

RAW will appear beneath the thumbnails 
of RAW format images.
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3 Click [Download].

The downloaded images will copy to the folder created in Creating a Folder to Receive 
Downloaded Images, and appear in the Browser Area.

Continue by printing out an image.

•You can also download images to the computer by dragging them from 
the Camera Window and dropping them on the Browser Area or the 
Explorer View Section.

•To close the connection to the camera, click the close box  (Mac OS 9) 
or the red close box  (Mac OS X) at the top left of the Camera 
Window.

•Your camera uses a standard image transfer protocol called the Picture 
Transfer Protocol (PTP). With the PTP protocol and Mac OS X, you can 
easily download images by connecting the camera to the computer with 
an interface cable and using the software preinstalled on your 
operating system, such as iPhoto and Image Capture. (You do not even 
need to install ImageBrowser.) However, there are some inconveniences 
and limitations to this downloading method. See the For Windows® XP 
and Mac OS X Users leaflet for details. 

The movie icon 
displays on movie 
thumbnails.

Browser Area

RAW will appear 
beneath the thumbnails 
of RAW format images.
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Printing Images

Printing

1 Select the image(s) to print.
A blue frame appears around selected images.

2 Click the [Print] button and select 
[Layout printing] from the displayed 
menu.
This displays the Layout Options dialog and 
the Print window.

The next steps differ according to whether you select Full Page Print (one image per page) 
or Layout and Print (multiple images arranged on one page).

 Full Page Print

This option prints one image per page.

1 Confirm that [Tiled photo printing] is selected in the Layout Options dialog and 
click [Next]. 

2 Once you have set the paper size and other settings, select [1 (1 x 1)] in the No. of 
images category and click [OK].

3 Click the [Print] button in the Print window.
This will display the Print dialog.

4 Click [Print] to start printing.

Movie images cannot be printed. 

Layout Options dialog

Print window
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Layout and Print

This option prints multiple images on a single page as in a photo album. 

1 Select [Custom layout printing] in the Layout Options dialog and click [Next].
2 Select settings, such as the paper size, and click [OK].
3 As required, change the layout and add text in the Print window.

See Print Window Features (p. 61) for the procedures for changing layouts and adding 
text.

4 Click the [Print] button in the Print window.
This will display the Print dialog.

5 Click [Print] to start printing.

•You can print an index print by selecting [Index printing] in the Layout 
Options dialog.

• Images shot with Exif 2.2-compliant cameras (Exif Print) incorporate 
information about the shooting settings, such as the camera modes and 
settings. Better prints can be made by using this information to correct 
the image. You can set this function by clicking the [ImageBrowser] 
menu and selecting [Preferences] (in Mac OS 9, click the [Edit] menu to 
select [Preferences]), followed by [Print] in the list box and [Image 
Correction Settings]. 
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Print Window Features

When the [Custom layout printing] option is selected in the Layout Options window, you can 
freely change the size and position of the images for printing.

This chapter explained the ImageBrowser basics. 

Once you have mastered them, read the following chapter to try the advanced 
techniques.
Using the Software on the Macintosh Platform – Advanced Techniques (p. 62). 

A PDF-format manual for ImageBrowser is also available. It provides 
further information about the program's features and procedures. See 
Using the PDF Manuals (p. 2).

Change the Image Size
Drag the border to 
resize the image. 

Change the default 
number of images 
printed per page.

Rotate the selected 
image. 

Vertically and 
horizontally lines up 
images in the 
window.

Edit the Page Title
Open the [Edit] menu 
and select [Edit 
Header].

Change the Layout
Drag the images to 
change the layout.

Add Text
Open the [Edit] menu 
and select [Add Text].

Add Captions to Images
Click the image and 
then the [Edit] menu 
and select [Edit 
Caption].

Displays the Layout 
Options window.

Displays the Print dialog.
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Using the Software on the Macintosh 
Platform – Advanced Techniques

This chapter explains how to use various ImageBrowser features, such as how to play movies 
and create panoramic images.
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the 
Using the Software on the Macintosh Platform – The Basics chapter.

Replaying Movies
1 Double-click an image with a movie icon in ImageBrowser’s Browser Area.

QuickTime Player will start. 

2 Click the play button  in QuickTime 
Player.
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Editing Movies (Mac OS X Only)
You can create and edit movies: link movies and stills that have been downloaded to your 
computer, add background music, superimpose titles and other text, and apply various effects 
to the movies. 

1 Select the image(s) to edit in ImageBrowser’s Browser Area (movies or stills). 
You can select multiple movies or stills.

2 Click the [Edit] menu and select [Movie Edit]. 

3 Follow the steps displayed in the middle of the window to edit the movie and save 
it. 

Click this button 
to play the movie 
being edited.

Follow these steps 
to proceed.

Storyboard Area
Displays thumbnails of the 
selected images.
Links images in order from 
left to right.

Click this button for 
detailed 
operational 
instructions.

Transition Effect Box
Appears between adjacent 
images and displays the 
symbols of the transition 
effects linking images.

Guidance
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Converting RAW Images
RAW images are extremely high-quality images that are not subject to any deterioration due to 
compression processing. Since they are recorded with a special file format, they cannot be 
opened by many image editing programs.  It is necessary to convert them to standard image 
file formats, such as TIFF or JPEG.

Procedures for Converting RAW Images

1 Select a RAW image in ImageBrowser’s Browser Area.
2 Click the [File] menu and select [RAW Image Processing].

The main window, the Navigator window 
and the Image Quality Adjustment Window 
will display.

Use the buttons here to switch between 
images and display modes, rotate images, 
and set the conversion parameters.

Thumbnail

Check Mark

3 Adjust the image quality as required in the Image Quality Adjustment Window.
This window is explained in the Functions of the Image Quality Adjustment Window
section.

•See Information about Your Camera (p. 92) to determine whether your 
camera model supports this function.

•See the Camera User Guide for information about the camera settings for 
shooting RAW images.

If the navigator window or the Image Quality Adjustment Window do 
not display, click the [View] menu and select [Show Navigator] or [Show 
Image Quality Adjustment Window].

Main Window
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4 Click the [2. Save] tab, set the file 
format and destination, and then click 
[Save].

Select [All Images] or [Checked Images] 
(images checked in the main window) to 
apply the common conversion settings.

Select a file format

Set the file destination

You can also change the image file name

This will convert the image.

5 Click the [3. Exit] tab and click [OK].

Functions of the Image Quality Adjustment Window

The following adjustments can be made in the Image Quality Adjustment Window.

You can change the coloration of the image to your preferred settings when 
you convert a RAW image. You can also select preset color schemes, such as 
Positive Film. Furthermore, you can add your own color schemes (My Color) to 
apply to other RAW images when they are being converted. See the PDF 
manual for ImageBrowser for more information (p. 2).

This section adjusts the 
white balance according 
to the light source and 
color temperature.

This section adjusts the 
digital exposure, photo 
effect, contrast, 
sharpness, and saturation.

The effect of the settings 
above can be viewed 
immediately if you place a 
check mark here.

Tone Curve Tab
You can set the levels for 
the RGB channels 
separately or together.

Advanced Adjustments 
Tab
You can set the settings 
for adaptive noise 
control, false color filter 
and the color space for 
the output. (Click the 
arrow to display the tab)

If you cannot set the 
desired setting with the 
slider on the left, 
directly enter the setting 
here.

Applies the settings to 
the displayed image

Restores all settings to the 
settings stored in the 
camera at the time of 
shooting.
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Operating the Shutter Remotely
You can record still images by using a computer to control the shutter of a connected camera. 
This is particularly useful for checking images on the larger display of the computer as you 
record them and for high volume photography without worrying about filling the camera’s 
memory card.

Preparing for Remote Shooting

1 Ensure that the camera is connected to the computer and that ImageBrowser is 
displaying its Browser Window.
Close the Camera Window if it appears.

2 Open the lens cover or remove the lens cap on models equipped with them. 
Proceed to the next step if your model does not have one. 

3 In the Browser Area, select the folder in which images will be saved.
The folder selected here will be the folder into which the remote shooting images are 
saved.

4 Click the [Edit] menu and select [RemoteCapture].

Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See 
Information about Your Camera (p. 92).
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RemoteCapture Task Window 

The RemoteCapture Task window has the following features.

•The settings available in the RemoteCapture Task window vary between 
camera models. 

•RemoteCapture Task locks the exposure and focus settings for the subject 
matter in the Viewfinder section. If the lighting or distance to the subject 
changes, click  to reset these settings.

Size and Resolution Selector
Selects the size and resolution at which 
images are captured.

You can add 
comments to images 
by placing a check 
mark here and 
typing text in the 
boxes below. 

Viewfinder Display
Click the [Start/Stop 
Viewfinder] button 
while a connection to 
the camera is open to 
display the image 
appearing in the 
camera’s viewfinder.

Slide this to zoom 
the camera in or out.

Set the basic camera settings here.

Rotation Settings
Sets the rotation 
parameters for 
images after they are 
captured.

Shows/Hides the 
viewfinder or 
detailed settings 
area.

Release Button
Releases the 
shutter.

Start/Stop Viewfinder 
Button
Starts or stops the 
viewfinder display.

Refresh Button
Resets the exposure, 
focus and white 
balance.
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Remote Shooting

1 Click  and check the subject in the viewfinder.
2 Change the image size or resolution, the rotation settings and the settings at the 

bottom of the window as required. 
If you intend to tilt the camera 90 degrees on end to photograph a person, you can save 
the image to the computer with the correct orientation if you set the rotation settings in 
advance.

3 Click the [Release] button.
The recorded image is saved to the folder that was displayed in the window when the 
remote shooting procedures were initiated.

Ensure that you turn off your computer’s sleep mode before you begin remote 
shooting. The device performance cannot be guaranteed if the computer 
enters the sleep mode.

If your camera is equipped with the Auto Rotate function and you set it 
to On, the image will automatically be rotated and appear in the correct 
viewing orientation in the RemoteCapture Task window.

•You can release the shutter by pressing the camera’s shutter button or 
the keyboard’s space key.

•The zoom controls and other camera buttons and switches, except for 
the shutter button, cannot be operated while the camera is being used 
for remote shooting.

•You may notice that the interval between the shutter release and 
activation is slightly longer for remote shooting than when the camera 
is used independently. 
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Other Features

Changing the File Saving Method
1 Click the [RemoteCapture Task] menu and select [Preferences].

For Mac OS 9, click the [File] menu and select [Preferences].

2 Select a file settings option and click 
[OK].

Sets whether images are saved only to the 
computer or to both the computer and the 
memory card in the camera.

Input a root name for the image files here. 
If you input “Capture”, for example, the first 
image will be named [Capture_00001.JPG] 
and successive images will automatically be 
assigned a name that is one number higher 
than the last. You can also change the 
number of digits and the starting number.

Displaying the Subject in the Camera's LCD Monitor
You can view the subject you are shooting in the camera’s LCD monitor. 

1 Click the [File] menu and select [Camera Display Settings].
2 Select [Camera’s LCD monitor] and click [OK]. 
3 Click the  icon. 

Selecting [Computer only] in the "Save Images On" category allows you 
to shoot when there is no memory card in the camera or when the 
camera's memory card is full.

You can display the subject on a TV connected to the camera by selecting 
[Video Out terminal] in Step 2. See the Camera User Guide for 
instructions to connect the camera to a TV.
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Merging Panoramic Images - PhotoStitch 
You can create a wide panoramic image by merging several images, such as those shot in the 
camera's Stitch Assist mode.

Starting PhotoStitch 

1 Select a series of images in the ImageBrowser’s Browser Area. 
2 Click the [Edit] menu and select 

[PhotoStitch].

Follow the instructions to merge the images.

3 Merge the images following the instructions in the guidance panel at the top of 
the PhotoStitch window.

Images Shot in Stitch Assist Mode 

It is easy to merge images shot with the camera's Stitch Assist mode since PhotoStitch 
automatically arranges them in the correct order and orientation.

Images shot in Stitch Assist mode display a mark 
like this. 

Camera Window

Images shot in Stitch Assist mode with a wide converter, 
teleconverter or close-up lens cannot be merged accurately. 
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Enjoy Customizing Your Camera with the My 
Camera Settings
The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are 
called the My Camera Settings. You can add your favorite images and sounds from your 
computer to the My Camera Settings. This topic explains how to upload the My Camera 
Settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window

1 Connect the camera to the computer, start ImageBrowser and display the Camera 
Window. 
For starting instructions for ImageBrowser, see Starting ImageBrowser (p. 50).

2 Click [Setup Options] in the Camera 
Window and select [My Camera].

3 Select [Start-up Image, Start-up Sound, 
Operation Sound, Selftimer Sound and 
Shutter Sound] and click [OK].

•You can also start PhotoStitch by clicking the mark shown on images shot in 
Stitch Assist mode.

•See the Camera User Guide for information about shooting in Stitch Assist 
mode.
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The My Camera Window

ImageBrowser already contains several pre-recorded My Camera Settings items. You can check 
these items with the My Camera window

Saving the My Camera Settings to the Camera

You can add new files as My Camera Settings to the My Camera window. See 
Adding New Data to the My Camera Window (p. 73). 

•My Camera Settings can be selected and saved in either of two ways to the 
camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the start-up image 
and animal calls in each of the sound files. The names of the prepared files 
for the various My Camera Settings themes all begin with the same root 
name, such as “Animal~”. For example, the start-up image that starts with 
“Animal~” shows an animal picture while the similarly named sound files 
feature animal sounds.

Do not detach the interface cable, turn the camera power off or disconnect 
the camera from the computer while the My Camera Settings are being saved 
to the camera or the settings from the camera are being saved to the 
computer. 

Type 
Select the settings type. 

Displays the list 
of settings files 
saved onto the 
computer.

Add Button
Adds the settings 
file to the list.

Play Button
Plays the audio from the 
selected settings file.

Send to Trash Button
Deletes a settings file 
from the computer.

Save to Camera Button
Click here to save the 
settings onto the 
camera.

Delete Button
Deletes a settings 
file from the 
camera.

Displays the 
settings in the 
camera.

Play Button 
Plays the audio from 
the settings file in the 
camera.

Save to Camera
Save to Computer 
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1 Select the type of setting in the Type list box that you wish to save to the camera.
2 Select the setting from the Computer list that you would like to add.
3 Select the setting in the Camera list that you would like to change and click the 

 button.
The Camera list setting will change to the selected file. If a setting for this category has 
previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

4 Click the [Save to Camera] button.
This concludes the process of saving the My Camera Settings to the camera. 
To use this data on the camera, change the start-up image and sound settings on the 
camera itself. Please see the Camera User Guide for these instructions. 

Saving the Camera’s My Camera Settings to the Computer

1 Select the type of setting you wish to save to the computer from the Type list box.
2 Select the setting in the Camera list that you wish to save to the computer. 
3 Click the  button.
4 Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera Settings to the computer. 
Repeat steps 1-4 as required.

Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.

Create an Original Start-up Image File and then Add It
Start by using an image editing program to create the image file that will become the start-up 
image and save it to the computer. Create the file in the JPEG format at a size of (w) 320 x (h) 
240 pixels.

1 Open the My Camera window, select the type of setting you wish to add from the 
Type list box.

2 Click the [Add] button.
3 Select the file you created and click 

[Open].
This concludes the process for adding new 
data.
You can save the newly created data to the 
camera using the procedures described in 
the Saving the My Camera Settings to the 
Camera section (p. 72).



Enjoy Customizing Your Camera with the My Camera Settings74

Add an Original Sound File
Use a program such as ArcSoft VideoImpression to change the file format to the WAV format 
after you have copied the sound file. Then proceed with the steps as described in Create an 
Original Start-up Image File and then Add It.

•With Mac OS 9, you can use the standard-issue SimpleSound program to 
record a sound file.

•Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono sound in 
the WAV format. The following chart shows standard time lengths for 
My Camera Sounds.

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Appendices

This chapter introduces the CD-ROMs supplied with your camera and the procedures for 
installing the programs. It also explains how to uninstall the programs.
Read the Troubleshooting section in this chapter if you experience a problem using the 
programs.

About the CD-ROMs Supplied with the 
Solution Disk
Apart from the Canon Digital Camera Solution Disk, additional CD-ROMs containing image 
editing programs may be supplied with your camera. This topic explains the program features 
and installation procedures for the programs on these CD-ROMs.

ArcSoft Camera Suite 2.1 CD-ROM

This CD-ROM contains the following programs.

The free hard disk space required to install ArcSoft Camera Suite 2.1 is 250 MB or more on a 
Windows system and 500 MB or more on a Macintosh system.
* Compatible with Windows 98 SE (Second Edition) only.

The CD-ROMs supplied with the cameras differ by model. See Information 
about Your Camera (p. 92).

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

ArcSoft 
PhotoStudio

ArcSoft
VideoImpression *
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What Can Be Accomplished with ArcSoft Camera Suite 2.1
Special Effects and Image Editing for Various Purposes
•ArcSoft PhotoStudio
This program can be used to correct image color or brightness, apply special effects, and edit 
and print images. ArcSoft PhotoStudio is a high-performance, yet easy-to-use photo editing 
program from ArcSoft, Inc.

Programs for Editing Stills and Movies
•ArcSoft VideoImpression
This program provides simple procedures for compiling a movie from multiple movie clips or 
stills and for editing out unwanted frames from movies.

Installing ArcSoft Camera Suite 2.1

Windows 

1 Close all programs that are running.
2 Place the ArcSoft Camera Suite CD-ROM in the drive.

Follow the onscreen messages to install PhotoStudio and VideoImpression.
If the message does not appear automatically, click the Windows [Start] menu, select [My 

Computer], and double-click the [ARCSOFT] and [Setup.exe] icons .
Windows 2000, Windows Me and Windows 98 users should double-click the [My 

Computer] icon on the desktop, followed by the [ARCSOFT] and [Setup.exe] icons .

Macintosh
•Installing ArcSoft PhotoStudio

1 Close all programs that are running.
2 Place the ArcSoft Camera Suite CD-ROM in the drive.

3 Open the CD-ROM window and double-click the [Installers], [English] and 

[PhotoStudio Installer] icons .

Follow the onscreen messages to proceed with the installation.

4 Click [Finish] when the message stating that the installation is complete appears.
Continue by installing ArcSoft VideoImpression.

•Installing ArcSoft VideoImpression

1 In the CD-ROM window, double-click the [Installers], [English] and 

[VideoImpression 1.6 Installer] icons .

Follow the onscreen messages to proceed with the installation.

2 Restart the computer after the installation is complete.
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ArcSoft Camera Suite 1.3 CD-ROM 

This CD-ROM contains the following programs.

The free hard disk space required to install ArcSoft Camera Suite 1.3 is 700 MB or more on a 
Windows system and 500 MB or more on a Macintosh system.
* Compatible with Windows 98 SE (Second Edition) only.

What Can Be Accomplished with ArcSoft Camera Suite 1.3
Special Effects and Image Editing for Various Purposes
•ArcSoft PhotoImpression
This program can be used to apply special effects, and edit and print images in simple steps. It 
can also be used to create postcards and calendars.

Programs for Editing Stills and Movies
•ArcSoft VideoImpression
This program provides simple procedures for compiling a movie from multiple movie clips or 
stills and for editing out unwanted frames from movies.

Installing ArcSoft Camera Suite 1.3

Windows 

1 Close all programs that are running.
2 Place the ArcSoft Camera Suite CD-ROM in the drive.

Follow the onscreen messages to install PhotoStudio and VideoImpression.
If the message does not appear automatically, click the Windows [Start] menu, select [My 

Computer], and double-click the [ARCSOFT] and [Setup.exe] icons .
Windows 2000 and Windows Me users should double-click the [My Computer] icon on 

the desktop, followed by the [ARCSOFT] and [Setup.exe] icons .

Macintosh
•Installing ArcSoft PhotoImpression

1 Close all programs that are running.
2 Place the ArcSoft Camera Suite CD-ROM in the drive.

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

ArcSoft 
PhotoImpression *

ArcSoft
VideoImpression *
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3 Open the CD-ROM window and double-click the [Installers], [English] and 

[PhotoImpression Installer] icons .

Follow the onscreen messages to proceed with the installation.

4 Click [Finish] when the message stating that the installation is complete appears.
Continue by installing ArcSoft VideoImpression.

•Installing ArcSoft VideoImpression

1 In the CD-ROM window, double-click the [Installers], [English] and 

[VideoImpression 1.6 Installer] icons .

Follow the onscreen messages to proceed with the installation.

2 Restart the computer after the installation is complete.

Starting the ArcSoft Camera Suite Software

The Arcsoft Camera Suite software can be started from ZoomBrowser EX or ImageBrowser.

For Windows 
1 After you select an image to edit, click [View & Modify] in the main window, 

followed by [Edit Image] in the next menu.

For Macintosh
1 After you select an image to edit, click the [Edit] menu and select the program to 

start up. 

Manual for the ArcSoft Camera Suite 

See inside the [Manuals] folder on each CD-ROM for the manuals. 

Set the following settings if the ArcSoft Camera Suite software did not 
start.
1 Click the [Tools] menu in the ZoomBrowser EX main window and select 

[Preferences].
2 Click the [Image Editor] tab in the Preferences dialog and select the 

program you wish to start.

Use the following procedures to start ArcSoft VideoImpression.
1 Click the [ImageBrowser] menu in ImageBrowser’s Browser Window 

and select [Preferences] (or click the [Edit] menu and select 
[Preferences]) and register VideoImpression (first time only).

2 After you select an image to edit, click the [Edit] menu, followed by 
[Start Application] and [VideoImpression] to start VideoImpression.
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Uninstalling the Software
The procedures for uninstalling the software are only required when you wish to delete the 
programs from your computer or when reinstallation is required to fix corrupted files.

Uninstalling the Software (Windows)

Software Installed from the Canon Digital Camera Solution Disk 
This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program.

1 Click the Windows [Start] menu and 
select [Programs] or [All Programs], 
followed by [Canon Utilities], 
[ZoomBrowser EX] and [ZoomBrowser 
EX Uninstall].

The uninstall utility will start and remove 
ZoomBrowser EX.

Uninstalling the Other Supplied Programs
ArcSoft PhotoStudio, PhotoImpression and VideoImpression 

Uninstall these programs by clicking the Windows [Start] menu and selecting [Programs] or 
[All Programs], followed by [ArcSoft Camera Suite] and [Uninstall].

Uninstalling the USB Driver (Windows 2000,Windows Me, and Windows 
98 only)

Use the following procedures to uninstall the USB driver.

•You can remove other programs with the same procedures. 
•PhotoRecord can be uninstalled by clicking the Windows [Start] menu 

and selecting [Programs] or [All Programs], followed by [Canon 
PhotoRecord] and [PhotoRecord Uninstall].

It is essential to note that you will not be able to download images if you 
uninstall the USB driver.

You do not need to uninstall the USB driver with Windows XP.
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1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
Digital Terminal. Prepare the camera for communication with the computer.
For interface cable connection instructions, see Information about Your Camera (p. 92). 
A dialog allowing you to select which application program to start will display.

2 Click the [Cancel] button.
If ZoomBrowser EX is started, close it.

3 Click the [Start] menu and select 
[Settings], followed by [Control Panel].

4 Double-click the [Scanners and 
Cameras] icon or folder.

5 Delete your camera model name or 
[Canon Camera] in the [Scanners and 
Cameras Properties] dialog.
Windows Me users should delete their 
camera model or [Canon Camera] in the 
[Scanners and Cameras] folder.



81

Windows 2000/Windows 98
Select your camera model name or [Canon Camera] and click [Remove].

Windows Me
Select your camera model name or [Canon Camera], right-click the mouse and select 
[Delete].

6 Click the Windows [Start] menu and select [Programs] or [All Programs], followed 
by [Canon Utilities], [Camera TWAIN Driver x.x] and [Uninstall TWAIN Driver]. (A 
version number appears in place of the “x.x”.)
• Windows 2000, Windows 98: Perform Step 6 with no substitutions.
• Windows Me: Substitute the following for the underlined portions of Step 6.

[Camera WIA Driver x.x], [Uninstall WIA Driver] 

The uninstall process will start.

To connect the camera to the computer and download after this point, use the following 
procedures.
1. Reinstall the driver.
2. Connect the camera to the computer with the interface cable. 

Uninstalling the Software (Macintosh)

Uninstall the programs by dragging the application’s folder (the folder in which it was installed) 
into the Trash, and then empty the Trash.

If your camera model name does not appear here, see the Camera not 
detected, Events dialog won’t display or images will not download to the 
computer (p. 84) of the Troubleshooting section.

Please be careful not to accidentally delete any folders with downloaded 
images that may be contained within the application folder. 
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Memory Card Folder Structure
The images on a memory card are placed in the [DCIM] folder in subfolders labeled 
[xxxCANON], where the “xxx” represents a number in the range 100 - 998. 

•*Files with the THM extension are the thumbnail image files for the camera’s index replay 
mode.

•The “xxxx” in file names represent four-digit numbers.
•**Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which 

is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG], 
[STC_0003.JPG]...

•All folders except the “xxxCANON” folders contain image settings files. Do not open or delete 
them.

IMG_xxxx.JPG (JPEG format images)
_MG_xxxx.JPG (JPEG format images recorded in 
the Adobe RGB color space)
CRW_xxxx.CRW (RAW format images)
_RW_xxxx.CRW (RAW format images recorded in 
the Adobe RGB color space)
CRW_xxxx.THM*
STx_xxxx.JPG** (Stitch Assist mode images)
MVI_xxxx.AVI (Movies)
MVI_xxxx.THM*
SND_xxxx.WAV (Sound annotation)

The folder that holds the settings files for 
images in the DCIM folder.

The folder created when DPOF settings are set. 
It holds the DPOF settings files.

DCIM

MISC

xxxCANON

CANONMSC
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Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer meet the following requirements?

Computer systems that fail to meet the following requirements to 
accommodate a camera connected by an interface cable are not 
supported. Please acquire the necessary system. 
• Built-in USB port on a system pre-installed with Windows XP, Windows 2000, 

Windows Me, or Windows 98 (First or Second Edition)
• System with a genuine Apple Computer built-in USB port

Is the camera correctly connected to the computer?

See Information about Your Camera (pp. 92 - 100) for the correct 
connection procedures. Also check to ensure that you are using the 
correct cable and that it is securely attached at both ends. 

Is the camera set to the playback mode? (some models only)

Some models require the camera to be set to the playback mode to 
transfer data. See Information about Your Camera (pp. 92 - 100) for 
details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery. 
You are recommended to use a household power source (AC adapter) to 
power the camera when it is connected to a computer (if available for 
your camera model).

Problems

Try the suggested solutions to the common problems listed below.

USB driver installation not proceeding well (Windows)
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Uninstall the driver (p. 79) before reinstalling it with the procedures in Installing 
the Software and USB Driver (p. 10). 

Add New Hardware Wizard or New Hardware Found (Windows 2000) 
Wizard displays when the camera is connected to the computer with an 
interface cable.

Click [Cancel] to close the window. Temporarily disconnect the camera from the 
computer. Next, read Start by Checking This on the previous page and resolve 
the problem.

Images won’t download into a TWAIN-compliant program. (Camera and 
computer connected via interface cable (Windows 2000, Windows 98))

Right-click the CameraWindow (Launcher) icon ( ) in the task tray at the 
screen’s bottom right to close it.

Camera not detected, Events dialog won’t display or images will not 
download to the computer (when camera is connected to the computer 
via an interface cable)

Cause 1:

There is a problem with one of the items in the Start by Checking This
section (p. 83).
Solution:

Resolve the problem.
Cause 2:

The USB driver is not installed. (Windows only)
Solution:

Install it with the procedures in Installing the Software and USB Driver (p. 10).
Cause 3:

The USB driver is not correctly installed. (Windows only)
Solution:

Uninstall the driver (p. 79) before reinstalling it with the procedures in Installing 
the Software and USB Driver (p. 10).
Cause 4:

The camera may have been recognized as another device under the 
following circumstances. (Windows only)
• The camera was connected to the computer before the USB driver was 

installed.
• The [Scanners and Cameras] icon or the [Scanners and Cameras] folder cannot 

be found in the [Control Panel] or the [Printers and Other Hardware] window.
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• Your camera model name, [Canon Camera] or a camera icon does not display 
in the [Scanners and Cameras Properties] dialog or the [Scanners and 
Cameras] folder.

Solution 1:

Start with the following procedures.
Install the USB driver with the procedures in Installing the Software and USB 
Driver (p. 10). Then connect the camera to the computer with the interface 
cable and prepare it to transfer data. If the USB driver is already installed, 
uninstall it first and then reinstall it.
Solution 2:

If the problem is not resolved with the procedures in Solution 1, continue by 
implementing the following procedures. The specific steps are explained below.
1. Check to see if the camera is being recognized as an “other” device.
2. Delete the driver and the setup information files if it is being recognized as an 

“other” device.
3. Reinstall the driver.

This section explains the specific steps for each operating system.

Windows XP and Windows 2000 

<Check to see if the camera is being recognized as an “other” device and 
delete the driver if it is.>

1. Windows XP: Click the [Start] menu, followed by [Control Panel], 
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and [Control 
Panel]. Double-click the [System] icon.

2. Click the [Hardware] tab, followed by [Device Manager].
3. Click the  symbol beside the [Other devices] and/or [Imaging devices] 

category. Your camera model name or [Canon Camera] will display in these 
categories if it is being recognized as an “other” device.

Users of Windows XP and Windows 2000 must first log in as an 
Administrator (computer system administrator) to delete a driver.
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4. Select your camera model name or [Canon Camera], right-click and select 
[Delete].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories.

6. Close the System Properties window.

< Delete the setup information files>

7. Double-click the [My Computer] icon on the desktop, followed by the [C:] 
drive, [Winnt] folder and [Inf] folder.

There are other potential reasons for the problem if the “Other devices” 
or “Imaging devices” categories do not appear or your camera model 
name or [Canon Camera] does not appear. Proceed to Step 6, 
temporarily quit the procedures and investigate the other potential 
causes.

Step 7 and above are not required for Windows XP.

If the [Inf] Folder Is Not Visible in the [Winnt] Folder
Use the following procedures to show all files and folders.

1. Open the [Winnt] folder.
2. Click the [Tools] menu and select [Folder Options].
3. Click the [View] tab.
4. In the [Files and Folders] category in the Advanced Settings section, set [Hidden files 

and folders] to [Show hidden files and folders]. Remove the check marks from [Hide 
file extensions for known file types] if it is present.

5. Click [OK] to close the dialog.

This will make the hidden files and folders visible.
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8. Look for files for Canon digital cameras that start with [Oem*]. 
The “*” represents a number, such as 0 or 1. 
[Oem*] files come in pairs of [Oem*.inf] and [Oem*.pnf] files. (For example, 
[Oem0.inf] and [Oem0.pnf]). 

9. Double-click the [Oem*] files to check their contents. 
Double-clicking an [Oem*.inf] file will open it in the Windows Notepad 
program. Look for [;***Canon Camera Driver Setup File****] in the first line. 
Note down the names of these files.

10.Delete the [Oem*] file set.
Delete the [Oem*.inf] and [Oem*.pnf] file for Canon digital cameras that 
you noted down in Step 9.

<Reinstall the driver.>

11.Reinstall the driver with the procedures in Installing the Software and USB 
Driver (p. 10).

Windows Me/Windows 98 
<Check to see if the camera is being recognized as an “other” device and 
delete the driver if it is.>

1. Click the [Start] menu and select [Settings], followed by [Control Panel]. 
Double-click the [System] icon.
This will display the System Properties window.

2. Click the [Device Manager] tab.

Several sets of [Oem*] files may be present in the [Inf] folder. Open up 
each file to confirm that it is an [Oem*] file for Canon digital cameras 
before you do anything with the file.

The Inf folder contains numerous files critical to the computer’s 
operation. Be extremely careful to delete the correct files. If you delete 
the wrong files, you may be unable to restart Windows.
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3. Click the  symbol beside the [Other devices] and/or [Imaging devices] 
category. Your camera model name or [Canon Camera] will display in these 
categories if it is being recognized as an “other” device.

4. Select your camera model name or [Canon Camera] and click [Remove].
5. Click [OK] in the confirmation dialog.

Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories.

6. Click [OK] to close the System Properties window.

< Delete the setup information files.>

7. Double-click the [My Computer] icon on the desktop, followed by the [C:] 
drive, [Windows] folder and [Inf] folder.

There are other potential reasons for the problem if the “Other devices” 
or “Imaging devices” categories do not appear or your camera model 
name or [Canon Camera] does not appear. Proceed to Step 6, 
temporarily quit the procedures and investigate the other potential 
causes. 
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8. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.
9. In the [Inf] folder, double-click the [Other] folder to open it.

10. Find and delete the [Canon.IncCAP_xxx.Inf] file. (The xxx 
represents numerals.)

<Reinstall the driver>

If the [Inf] Folder Is Not Visible in the [Windows] Folder
Use the following procedures to show all files and folders.

1. Windows 98: Click the [View] menu and select [Folder Options]. 
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.
3. Windows 98: Set the [Hide files] section to [Show all files].

Windows Me: Set the [Hidden files and folders] section to [Show hidden files and 
folders].

4. Click [OK] to close the dialog.

This will make the hidden files and folders visible.

You do not need to delete anything if none of the above files are 
contained in the [Other] folder.

The [Inf] folder contains numerous files critical to the computer’s 
operation. Be extremely careful to delete the correct files. If you delete 
the wrong files, you may be unable to restart Windows.
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11.Reinstall the driver with the procedures in Installing the Software and USB 
Driver (p. 10).

“Server Busy” Displays During Image Download

Use the following procedures if a window similar to the one below appeared when you 
downloaded images with ZoomBrowser EX running on Windows XP.

1. Click [Retry].
If this screen appears again, click 
[Retry] until it disappears.

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX 
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration 
setting to a lower setting. 

1. Click the Windows [Start] menu, followed by [Control Panel] and 
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98, click the [Start] menu 
and select [Settings], followed by [Control Panel]. 

2. Click the [Display] icon, followed by the [Settings] tab, [Advanced] button and 
[Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings] tab, 
[Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98, click the [Display] icon, followed by the 
[Settings] tab, [Advanced] button and [Performance] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.
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If You Were Using ZoomBrowser EX Version 2 or 3

Take the following steps if you were using ZoomBrowser EX version 2 or 3 with Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 4 the titles and comments you 
input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in 
which you installed ZoomBrowser EX 4. 
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Program)

2. Double-click [dbconverter.exe] found in this folder to start this utility.
3. Select the database file you were using up to this point and click the [Start] 

button. 
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd)

This will display the titles and comments input in the earlier versions in the 
comments section of ZoomBrowser EX 4.

If You Had Images in a Folder Below the Program Files Folder
Image files in the [Program Files] folder or a subfolder cannot be displayed in 
ZoomBrowser EX 4 from that location. To display these files, first perform steps 
1-3 above and then carry on with Step 4.

4. Use Windows Explorer to copy the folder and the images it contains from the 
[Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser 
EX\Library One to another location.)

The moved folder images can now be selected and displayed with 
ZoomBrowser EX 4.
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Information about Your Camera

The software package and the procedures for connecting to a computer and preparing for data 
transfers vary between camera models. Certain software functions may also not be supported 
by some camera models. 
Read this section to confirm the capabilities of your camera model. 

Information Common to All Models
See the respective page for your camera model for information specific to that model (pp. 94 - 
100).

Programs and Compatible Operating Systems

The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all models. It 
contains the following programs.

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

ZoomBrowser EX

ImageBrowser

TWAIN Driver

WIA Driver

PhotoRecord

PhotoStitch
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Connecting the Camera to a Computer

Item to Prepare
•Your camera and computer
•Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

See the page (pp. 94 - 100) for your specific model for information about connecting the 
camera to the computer.

Ensure that you have installed the software from the supplied Canon Digital 
Camera Solution Disk before you connect the camera to the computer. 

•Use the interface cable to attach the camera directly to a USB port on the 
computer, not through a USB hub. The connection may not operate correctly 
through a USB hub.

•The connection may not operate correctly if you are using other USB devices, 
excluding USB mice or keyboards, at the same time as the camera. If this 
occurs, disconnect the other devices from the computer and try reconnecting 
the camera.

•Do not connect two or more cameras at the same time to the same computer 
via the USB interface. The connections may not operate correctly.

•Never allow the computer to go into standby (sleep) mode while a camera is 
connected via the USB interface. If it does happen, never disconnect the 
interface cable. Try to awaken the computer with the camera in the 
connected state. Some computers will not awaken properly if you disconnect 
the camera while they are in standby (sleep) mode. Please refer to your 
computer manual for instructions regarding the standby (sleep) mode.

You are recommended to power the camera from a household power source 
(AC adapter) when connecting to a computer (if available for your camera 
model). Ensure that you use fully charged batteries if you will not be using a 
household power source. 
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PowerShot Pro 1

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal as shown below.

The camera and computer will automatically set themselves to the correct mode for 
communicating when they are connected.

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 2.1 
See ArcSoft Camera Suite 2.1 CD-ROM (p. 75) for information about the features and 
installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

Does not support with the Direct Transfer function.

Images Recorded in the Adobe RGB Color Space
* The images will appear desaturated when displayed in ZoomBrowser EX/ImageBrowser.
* The image printouts will appear desaturated when printed from PhotoRecord/
ImageBrowser.

Warning about Operating the Camera Shutter from the Computer (Remote 
Shooting)
In macro mode, it may be difficult to focus when the zoom is set to the 
maximum telephoto setting. Set the zoom to maximum wide angle to record.

USB Port

Interface Cable

To the DIGITAL 
Terminal

1. Open the terminal cover with your 
fingernail.

2. Hold the USB connector so the   
side is up, then insert it into the 
DIGITAL terminal securely. 
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PowerShot S1 IS

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal as shown below.

The camera and computer will automatically set themselves to the correct mode for 
communicating when they are connected.

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 2.1 
See ArcSoft Camera Suite 2.1 CD-ROM (p. 75) for information about the features and 
installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

Does not support with the Direct Transfer function.
The camera does not record RAW images.

To the DIGITAL 
Terminal

USB Port

Interface Cable
1. Slip a fingernail in the terminal 

cover’s slot to open it.
2. Orient the connector with the  

symbol up and insert it all the way. 



PowerShot S500 DIGITAL ELPH/DIGITAL IXUS 50096

PowerShot S500 DIGITAL ELPH/DIGITAL IXUS 
500

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal as shown below.

2 Set the mode switch to the playback mode and turn the camera’s power on.
This will prepare the camera to exchange data with the computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 1.3 
See ArcSoft Camera Suite 1.3 CD-ROM (p. 77) for information about the features and 
installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

The camera does not record RAW images.

USB Port

Interface Cable

To the DIGITAL 
Terminal

1. Slip a fingernail under the terminal 
cover and lift to open.

2. Insert it all the way until it clicks.
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PowerShot S410 DIGITAL ELPH/DIGITAL IXUS 
430

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal as shown below.

2 Set the mode switch to the playback mode and turn the camera’s power on. 
This will prepare the camera to exchange data with the computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 1.3 
See ArcSoft Camera Suite 1.3 CD-ROM (p. 77) for information about the features and 
installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

The camera does not record RAW images.

USB Port

Interface Cable
1. Slip a fingernail under the terminal 

cover and lift to open.
2. Insert it all the way until it clicks.

To the DIGITAL 
Terminal



PowerShot SD110 DIGITAL ELPH/DIGITAL IXUS II s98

PowerShot SD110 DIGITAL ELPH/DIGITAL 
IXUS II s 

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal as shown below.

2 Set the mode switch to the playback mode and turn the camera’s power on. 
This will prepare the camera to exchange data with the computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 1.3 
See ArcSoft Camera Suite 1.3 CD-ROM (p. 77) for information about the features and 
installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

The camera does not record RAW images.

USB Port

Interface Cable

To the DIGITAL 
Terminal

1. Slip a fingernail under the terminal 
cover and lift to open.

2. Insert it all the way until it clicks.
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PowerShot A75 

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal as shown below.

2 Set the mode switch to the playback mode and turn the camera’s power on. 
This will prepare the camera to exchange data with the computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 1.3 
See ArcSoft Camera Suite 1.3 CD-ROM (p. 77) for information about the features and 
installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

The camera does not record RAW images.

USB Port

Interface Cable

To the DIGITAL 
Terminal

1. Open the terminal cover by slipping 
a fingernail under its left edge.

2. Insert it all the way until it clicks.



PowerShot A310100

PowerShot A310 

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal as shown below.

2 Press the  (ON) button. 
This will prepare the camera to exchange data with the computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 1.3 
See ArcSoft Camera Suite 1.3 CD-ROM (p. 77) for information about the features and 
installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

The camera does not record RAW images.

USB Port

Interface Cable

To the DIGITAL 
Terminal

1. Open the terminal cover by slipping 
a fingernail in the groove and lifting.

2. Insert it all the way until it clicks.
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